
 
Plot No. 2, Knowledge Park-III, Greater Noida (U.P.) –201306 

POST GRADUATE DIPLOMA IN MANAGEMENT (2025-27) 

MID TERM EXAMINATION (TERM -II)    

Subject Name: Advanced Excel and Data Visualization           Time: 01.00 hrs 

Sub. Code: PG209               Max Marks: 20 

Note: All questions are compulsory.  

 

Answer the following questions carefully      40×0.5 = 20 Marks 

 

Kindly write the all the course outcomes as per your TLEP in the box given below: 

 

CO1- Use advanced Excel features to build analytical models using Pivot Tables, Charts, and 

interactive dashboards 

CO2- Evaluate best, worst and most likely case scenarios for varied business problems 

CO3- Analyze and collaborate on data using Google Sheets functions and integrated tools. 

CO4- Integrate Power Query for extracting, transforming, and loading structured datasets. 
 First 20 questions are mapped with CO1 (L4) and last 20 questions are mapped with CO2 (L3).  

 

To answer questions 1 to 4, assume the following data is in a sheet named 

Products, starting at cell A1. 
 

A B C D 

1 Product ID Name Category Price 

2 AX101 Laptop A Electronics 1200 

3 BY202 Keyboard B Accessories 75 

4 CZ303 Monitor C Electronics 350 

5 AX101 Mouse D Accessories 25 

6 DZ404 Printer E Peripherals 150 

7 EZ505 Tablet F Electronics 500 

 

1. A user enters the following formula in cell E2: 

=VLOOKUP(A2,A2:D7,3,FALSE) 

What result will be returned by this formula? 

A. Electronics 

B. Accessories 

C. #N/A 

D. Laptop A 

Correct Answer: A 

2. A user is trying to find the price for a new ID 'FZ606'. What will be the result of the following 

function? 

Roll No………… 



=VLOOKUP("FZ606",A2:D7,4,FALSE) 

A. #REF! 

B. 500 

C. #N/A 

D. 150 

Correct Answer: C 

3. If cell E2 contains: 

=IFERROR(VLOOKUP("GX707",A2:D7,2,FALSE),"Not Found) 

What is the output? 

A. #N/A 

B. #REF! 

C. Not Found 

D. Tablet F 

Correct Answer: C 

4. A user wants to find the category for any product starting with "Key". What is the result of: 

=VLOOKUP("Key*",B2:C7,2,FALSE) 

A. #N/A 

B. Accessories 

C. Electronics 

D. Keyboard B 

Correct Answer: B 

To answer the questions 5 to 6, assume the following data is in a sheet named 

Tiers, starting at cell A1. This table is used to determine a customer's discount 

based on their lifetime sales value. 

 
A B 

1 Minimum Sales Discount Rate 

2 0 0% 

3 1000 5% 

4 5000 10% 

5 15000 15% 

6 30000 25% 



 

5. A customer has lifetime sales of $3500. Which discount rate will the following formula 

return? 

=VLOOKUP(3500,A2:B6,2,TRUE) 

A. 0% 

B. 5% 

C. 10% 

D. #N/A 

Correct Answer: B 

6. A customer has lifetime sales of $4999. Which discount rate will the following formula 

return? 

=VLOOKUP(4999,A2:B6,2,TRUE) 

 

A. 0% 

B. 5% 

C. 10% 

D. #N/A 

Correct Answer: B 

To answer the questions 7 to 8, assume the following quarterly sales data is in a 

sheet named Sales_Data, starting at cell A1. 

 
A B C D E 

1 Item Q1 Q2 Q3 Q4 

2 Laptop 150 180 170 200 

3 Monitor 250 240 260 300 

4 Keyboard 400 450 390 420 

5 Mouse 600 620 580 650 

 

7. A user wants to find the Q2 sales for 'Keyboard'. What is the correct formula? 

A. =INDEX(B2:E5, 3, 2) 

B. =INDEX(A2:E5, MATCH("Keyboard", A2:A5, 0), MATCH("Q2", A1:E1, 0)) 

C. =INDEX(A2:E5, MATCH("Keyboard", A2:A5, 0), 3) 

D. =INDEX(B2:E5, MATCH("Keyboard", A2:A5, 0), MATCH("Q2", B1:E1, 0)) 



Correct Answer: D 

8. What value does the following formula return? 

=INDEX(D2:D5,MATCH("Mouse",A2:A5,0)) 

A. 580 

B. #REF! 

C. 420 

D. 600 

Correct Answer: A 

To answer the questions 9 to 12, assume the following data is in a sheet named 

Staff_List, starting at cell A1. 

 
A B C D 

1 Employee ID Name Department Hire Year 

2 E101 Alice Sales 2020 

3 E102 Bob Marketing 2018 

4 E103 Charlie IT 2021 

5 E104 David Sales 2019 

 

9. What does this formula return? =MATCH("Charlie",B2:B5,0) 

A. 2 

B. 3 

C. 4 

D. #N/A 

Correct Answer: B 

10. What value does the following formula return? =INDEX(C2:C5,4) 

A. IT 

B. Sales 

C. E104 

D. David 

Correct Answer: B 

11. What is the result of this formula? =INDEX(D2:D5,MATCH("Bob",B2:B5,0)) 



A. 2020 

B. 2018 

C. 2021 

D. Marketing 

Correct Answer: B 

12. Which of the following formulas is the best structure to find the Department for the employee 

with ID E104? 

A. =INDEX(C2:C5, MATCH("E104", B2:B5, 0)) 

B. =INDEX(A2:D5, MATCH("E104", A2:A5, 0), 3) 

C. =INDEX(A2:D5, 3, MATCH("E104", A2:A5, 0)) 

D. =VLOOKUP("E104", A2:D5, 3, FALSE) 

Correct Answer: B 

13. The main reason to use the "Text to Columns" feature is to: 

A. Combine data from multiple cells into one cell. 

B. Separate data contained within a single cell into multiple columns. 

C. Convert numbers stored as text into actual numerical values. 

D. Change the font or formatting of text. 

Correct Answer: B 

14. You have a column where each cell contains data formatted like this: ProductA-150-Blue. 

Which type of delimiter should you choose in the Text to Columns wizard to split this data 

correctly? 

A. Comma 

B. Space 

C. Semicolon 

D. Other (using the hyphen -) 

Correct Answer: D 

15. Before running the "Text to Columns" feature, your combined data is in cell A1. If you 

specify the Destination as B1, what happens to the original data in A1? 



A. It is deleted entirely. 

B. It remains in A1 unchanged, and the split data starts in B1. 

C. It is automatically moved to a new row. 

D. It is overwritten by the first part of the split data. 

Correct Answer: B 

Use the following Sales_Performance table to answer the questions 16 to 18. 

 
A B C D 

1 Employee Region Units Sold Target Met? 

2 Alice East 120 Yes 

3 Bob West 85 No 

4 Charlie North 150 Yes 

5 David South 95 No 

6 Eve East 100 Yes 

7 Frank West 130 Yes 

8 Grace North 70 No 

16. Highlight the Units Sold (Column C) only if the employee's sales are lower than the 

employee immediately above them. Which custom formula, applied to the range C3:C8, 

achieves this goal? 

A. =C2>C3 

B. =C3<C2 

C. =$C3<C2 

D. =C3<$C2 

Correct Answer: B 

17. Which Conditional Formatting rule is designed to show the distribution of Units Sold data 

(C2:C8) by applying a continuous color gradient from the lowest value (e.g., Red) to the 

highest value (e.g., Green)? 

A. Highlight Cells Rules (e.g., Greater Than) 

B. Top/Bottom Rules (e.g., Top 10%) 

C. Color Scales 

D. Icon Sets (e.g., Arrows) 

Correct Answer: C 

18. Highlight any cell in the Units Sold column (C2:C8) that results in a division error (#DIV/0!) 

due to bad source data. Which custom formula should be used? 



A. =ISNA(C2) 

B. =C2="Error" 

C. =ISERROR(C2) 

D. =ISERR(C2) 

Correct Answer: C 

19. A user applies a Top 10% rule to a list of 25 sales values. How many cells will be 

highlighted? 

A. 10 cells 

B. 3 cells 

C. 4 cells 

D. None of the above 

Correct Answer: B 

20. Which requirement is best suited for an Icon Set (e.g., 3-Color Traffic Lights)? 

A. Highlighting all cells that contain the word "Completed." 

B. Visually classifying data into distinct categories (e.g., Good, Neutral, Bad) based on 

thresholds. 

C. Identifying the single highest value in a range. 

D. Creating a custom border around every cell greater than 50. 

Correct Answer: B 

21. You have three rules applied to Units Sold column: 

I. Rule 1 (Top): If C2 > 100 (Fill: Blue, Stop If True) 

II. Rule 2 (Middle): If C2 > 80 (Fill: Green) 

III. Rule 3 (Bottom): If C2 > 50 (Fill: Yellow) 

If the value in cell C2 is 110, what is the resulting color of cell C2? 

A. Yellow 

B. Green 

C. Blue 

D. No Fill 



Correct Answer: C 

To answer the questions 22 to 23, use the following table: 

 
A B C D 

1 Order ID Product Region Quantity 

2 1001 Mouse East 10 

3 1002 Keyboard West 5 

4 1001 Mouse East 10 

5 1003 Monitor North 8 

6 1004 Mouse East 12 

7 1002 Keyboard West 5 

8 1005 Monitor North 8 

22. A user selects the entire range (A2:D8) and runs "Remove Duplicates," but only checks the 

'Order ID' column (A). How many total rows will remain after the operation? 

A. 3 rows 

B. 4 rows 

C. 5 rows 

D. 8 rows 

Correct Answer: C 

23. The user selects the entire data set (A1:D8) and runs "Remove Duplicates," checking ONLY 

the 'Region' column (C). How many rows of data (excluding the header) will remain, and 

what is the last remaining region in the list? 

A. 4 rows; North 

B. 4 rows; South 

C. 8 rows; North 

D. 3 rows; North 

Correct Answer: D 

24. What is the conceptual cause of the #DIV/0! error? 

A. A formula is referring to a cell that has been deleted. 

B. A formula attempts to divide a number by a cell that contains text. 

C. A formula attempts to divide a number by a cell that contains zero or is empty. 

D. A formula attempts to divide a number by a value that is too large. 

Correct Answer: C 



25. A user enters the formula =A1+B1. Cell A1 contains the number 100, and cell B1 contains 

the text string "Hello". Which error will result? 

A. #NAME? 

B. #REF! 

C. #VALUE! 

D. #NUM! 

Correct Answer: C 

26. When does the ##### error (a string of hash symbols) typically appear in a cell? 

A. When a formula contains an invalid or misspelled function name. 

B. When the cell contains a numerical result (number or date/time) that is too wide to fit in the 

current column width. 

C. When a formula refers to a non-existent sheet or range. 

D. When a date or time value is negative. 

Correct Answer: B 

A formula in cell C1 is =SUM(A1:B1). A user then deletes Column B. Which error will appear in 

cell C1? 

A. #NAME? 

B. #REF! 

C. #VALUE! 

D. #NULL! 

Correct Answer: B 

27. You are using the formula =VLOOKUP("Apple", A1:B10, 2, FALSE). Assuming the fruit 

"Apple" is not found in the lookup column (A1:A10), what error will be returned? 

A. #NUM! 

B. #REF! 

C. #VALUE! 

D. #N/A 

Correct Answer: D 



28. A user attempts to calculate a total by entering the formula =SUMM(A1:A10) instead of 

=SUM(A1:A10). Which error will be returned? 

A. #NUM! 

B. #NAME? 

C. #REF! 

D. #NULL! 

Correct Answer: B 

29. If you want to create a dropdown menu in a cell that only allows users to select from a 

predefined set of text options, which Data Validation setting must you use? 

A. Whole Number 

B. Text Length 

C. List 

D. Date 

Correct Answer: C 

30. When setting up Data Validation, what is the purpose of the Input Message tab? 

A. To stop invalid data from being entered. 

B. To display a helpful pop-up message before the user starts typing in the cell. 

C. To display a mandatory error message after the user enters invalid data. 

D. To define the range of acceptable values. 

Correct Answer: B 

31. What is the primary function of a Pivot Table in data analysis? 

A. To hide selected data rows and columns from view. 

B. To summarize, aggregate, and rearrange large amounts of data for reporting and analysis. 

C. To sort and filter data quickly based on a single column. 

D. To automatically apply conditional formatting rules to cells. 

Correct Answer: B 

32. If you drag a numerical field (e.g., 'Sales Amount') into the VALUES area of a Pivot Table, 

what is the default aggregation function typically applied to that field? 



A. AVERAGE 

B. COUNT 

C. SUM 

D. MIN 

Correct Answer: C. SUM 

33. What is the essential requirement for the source data columns before creating a reliable Pivot 

Table? 

A. The data must be pre-sorted in ascending order. 

B. All columns must contain numerical data only. 

C. Every column must contain a unique and descriptive header (field name). 

D. The data must be in an Excel Table object. 

Correct Answer: C 

34. If you want to view a calculation broken down both by 'Region' (shown vertically) and 

'Month' (shown horizontally), which two Pivot Table areas would you use? 

A. Region in FILTERS, Month in ROWS. 

B. Region in VALUES, Month in COLUMNS. 

C. Region in ROWS, Month in COLUMNS. 

D. Both Region and Month in ROWS. 

Correct Answer: C 

35. If you want to calculate a total (e.g., Sum of Quantity) or an average, where in the Pivot Table 

field list should you place that numerical field? 

A. ROWS area 

B. COLUMNS area 

C. FILTERS area 

D. VALUES area 

Correct Answer: D 

36. If you accidentally drag a text field (like 'Customer Name') into the VALUES area, what 

default aggregation function will the Pivot Table typically apply? 



A. SUM 

B. AVERAGE 

C. COUNT 

D. MAX 

Correct Answer: C 

37. If the PivotTable Fields List has accidentally closed, how do you reopen it? 

A. Right-click the Pivot Table and select 'Show Field List.' 

B. Click the 'Analyze' (or 'PivotTable Analyze') tab on the ribbon and click the Field List button. 

C. Press the F1 key. 

D. Both A and B. 

Correct Answer: D 

38. You want to change the calculation in your Pivot Table from SUM to AVERAGE. Where do 

you access the settings to make this change? 

A. Right-click the Grand Total row label. 

B. Double-click the cell containing the calculated value (e.g., the cell labeled 'Sum of Sales'). 

C. Click the dropdown arrow next to the field name in the VALUES area of the Field List, and 

select Value Field Settings. 

D. Click the Design tab and select 'Change Data Source.' 

Correct Answer: C 

39. If you want to add a Slicer to your Pivot Table for interactive filtering, where do you find the 

command to insert a Slicer? 

A. The View tab on the ribbon. 

B. The Insert tab on the ribbon. 

C. The Analyze (or PivotTable Analyze) tab on the ribbon. 

D. The Home tab under "Find & Select." 

Correct Answer: C 

40. What does the letter 'H' in the function name HLOOKUP refer to? 

A. High 



B. Height 

C. Horizontal 

D. Helper 

Correct Answer: C 

 

 

 

 


